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Forward
The use of computer, both for generating documents/data and storing them, has become a critical factor
for many essential roles in Bahá'í Administration.  Moreover, there is a rapid movement in the 
computer environment where software and hardware are undergoing constant improvements; some 
older technologies are dropped and the newly introduce ones often bring very significant 
improvements.

This handbook is the main one of three; the two others, the User Handbook focuses on the user alone 
while the third, the NOF Mail-Webserver Handbook focuses on setting up the cloud services that 
support the holistic computer system described herein.

By this very nature, this handbook must constantly evolve to embrace these changes and yet there 
remains the underlying key concepts: good performance, relevant software and hardware as well 
protected, accessible and current backups that must be understood and put to practice. Therein lies the 
goal of this handbook -  to setup up a framework that ensures optimum performance of the office 
computer systems but to safeguard and store computer files.

Apart from performance and security, the third area is the remarkable facilities now available on the 
Internet to integrate and coordinate by virtue of new and innovative cloud services and feature-rich 
social networking.  For example, community events and contacts can be freely shared on a common 
calendar platform for anyone of the community with just a mobile phone can access. 

Although the handbook will touch on this issue of integration, it basically focuses on two approaches: 
to frame policies that assist users in attaining good performance and security from computer systems 
and secondly, to forward practical suggestions in software and hardware installations and maintenance 
to achieve these goals.

The Fundamental Computer System
The trend towards personal computing is in a portable device, independently powered with its own 
battery.  However where alot of data-entry work is needed – particularly numeric work to be done, the 
desktop may well suits that situation better.  There will be a number of different kinds of computing 
needs and each of these will be assess to find the most satisfactory solution; be it a simple tablet to a 
high-performance system.  Office work usually fits into the performance of the average entry system 
available on the market, whether it be a laptop or a desktop version 

The Hardware

Core System

The usual need for computing in office work is the basic laptop or desktop offerings on the market - -
see the appendix for the approximate specifications.  Presently there is preference for the laptop with its
portability and battery supply but even the simpler and smaller notebook models may well be 
appropriate.  Needs should be assess according to these criteria:

– Hours of daily use; part-time vs full-time

– Environment in which the computer will be used eg. Is there a desk, an accessible regular power
outlet, shared printer etc.
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It is to be noted that computer systems have a depreciation rate of 20% and thus all systems should be 
replaced before they are five years old.

Accessories

Office systems require the users not only to create documents and messages but to print, scan, post and 
email some of these.  Therefore these systems need:

– Home Network - Internet Connection: the home network most current implemented is a WiFi
type of hub/switch that has a few “wire” connections.  These switches are often provided by a 
particular telecom company along with a Internet package.  The two particular challenges at the 
Uganda Bahá'í National Centre are, one; the heavy construction of the centre itself which 
impedes the signal and two; the security framework within the network as not to allow external 
connections as well as the break of confidentially within that could lead to unauthorized 
viewing or downloading of sensitive files.  The first challenge could be overcome by securing 
the latest offerings in such equipment and the second reduced by good control from an 
experienced Systems manager -  backed up with a sound authorization policy – see appendix for
more details.  Note that desktop units may well need to be fitted with wireless Intranet cards.

– Scanner: There are now scanners that are now low-cost (~50USD) and that run simply by 
plugging into a USB2 connection.  Often there are Scanner/Printer combinations that are 
economical, functional and space-saving, such as the current HP2515 printer. 

– Printer: The black laser printer is the most economical and most supported kind of printer with 
HP types dominating the Uganda market – with that, unfortunately, a lot of counterfeit 
cartridges particularly are common in the shops.  The HP printers models are available, such 
Laserjet Pro 400 has been found to be economical, robust and with easily found replacement 
cartridges.  Colour laser printers are still costly, particularly with the price of replacement 
cartridges.   For modest colour printing needs, it is recommended to consider an inkjet type.  
When making the purchase, one needs to be sure that the printer software/driver CD and usually
a USB cable of good length is provided.

The Software

The average market offering usually has sufficient software to cover basic office needs.  Currently, 
Microsoft is the publisher of the current dominant operating system – (Windows 7 or 8) and therefore 
all newly acquired computer systems should be equipped with licensed copies of this operating system. 
Anti-virus and other functional basic software are listed in the Appendix.  There could be exceptions 
for this where very simple computing needs are required – eg. A smart phone for example. Moreover it 
is noted that the Windows OS is rapidly losing its dominance –still its predominant strong point: is that 
most store-bought hardware accessories will run off these systems without much effort in installation.  
As one or two of the listed software in the Appendix are quite large (>100MB) and downloading 
updates for each computer may draw excessively on the Internet bandwidth, a shared folder, possibility 
on one of the computers in the Secretariat, would store these updated software applications. 
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The User

The user is of course the most critical “component” of any computer system and the skill level and the 
primary focus of the user needs to be properly assessed so that hardware and software meets the user's 
needs.  The most common need is to doing word-processing and to receive and send email.  Moreover 
in Uganda and in many parts of the world, computer literacy is not a 'given' and many need basic 
training to reach a functional level of proficiency. 

To address this need, a simple training programme needs to be given to familiarize the user with the 
computer and how to “localize” and customize the computer to the user's work.

Secondly of equal importance is to give the user exposure to typing tutorials so that the user can reach 
proficiency fairly quickly.

There are a number of free online typing tutorial programmes as well as one free application that can be
installed on the host computer – no registrations are needed.

Online Free Typing Lessons

http://www.typingstudy.com/

http://www.sense-lang.org/typing/tutor/keyboarding.php

http://www.typing-lessons.org/

http://www.typeonline.co.uk/lesson1.html

Free Typing Practice Software: KiransTypingTutot1.0

https://skydrive.live.com/?cid=3179c4db665be40a&id=3179C4DB665BE40A!129

Maintaining the Fundamental Computer System
Regular maintenance is essential both for hardware and software of computer systems if they are to run
optimally.

Hardware Maintenance

Any environment poses some hardship on computer systems, particularly where there are novice users 
and/or where the physical environment is dusty and power unstable.  All computer systems must be 
plugged into a power guard given the history of the erratic main power in Uganda.  Desktop models 
will also need a UPS with sufficient battery life to ensure an easy power down when there is a loss of 
mains power.  Such batteries need to be replaced regularly (after 2-3 years use; when backup power is 
less than 5-10mins)  Keyboards and hand-devices (eg. Mouse) do wear out as well as collect dust – 
they are cheap enough to be replaced regularly (once a year?).  

Simple cleaning of all computer surfaces are to be done weekly with a fresh cotton cloth/handkerchief

Signs of failure, like difficulty in starting up or computer crashes, need technical assistance – see 
appendix for recommended technicians.
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Shut Down Procedure

Proper shut-downs ensure good start-ups, reduces dust infiltration and power-surge damage.

a) Shut down via the “Start Button” - allow any updates to be processed prior to physically 
unplugging-switching of the computer or laptop

b) With laptops – close the cover.  With desktops, turn over the keyboard and cover the computer 
with a dust-cover/cloth as well as other accessories such as printers etc.

c) With desktops, shut down the UPS (so that if power fails during the night, the battery doesn't 
become exhausted)

d) Ensure that the power-guard at the socket is in place.

Software Maintenance

Software updates, when available – usually via the Internet, are to be immediately down-loaded and 
applied as they offer both function and security improvements.

Using Cloud Services
Gmail, Yahoo!, Facebook are a few of the very many types of Internet services available to the public. 
One needs to be always conscious that “free” Internet-Cloud services are not truly in user control and 
that access to these services can be cut, without notice, for any reason – sometimes unknown ones, 
where access to this data can be lost forever.  These service providers are notorious for poor customer 
services – particularly as the customer has usually paid nothing for the service.   A number of accounts 
also have been hacked into through various means (eg. Phishing) and been disabled.  Therefore any 
data (emails, postings, photos etc) that is stored on the Internet must be regularly backed up on the 
“ground” - on the user's home system.  Ironically the reverse is also true – bad postings or photos 
uploaded unto cloud services – particularly social networks may be very difficult to “erase” and 
therefore wise caution is needed when using these cloud services.  The security of cloud services is still
somewhat immature and therefore any sensitive information; such as bank passwords etc should not be 
stored or posted in such services, if possible.  As a policy, all usernames, passwords and any registering
of other pertinent details for all such services that relate to the office are to be generated by the Systems
Manager so that these services are used securely.  The manager is to place all such information in the 
eRegistry (see section: Systems Manager).

Phishing – the bane of Cloud Services

Having accounts with cloud services; such as Gmail, Yahoo!, Facebook and all others is that fraudulent 
programmers develop, particularly emails that are very much like they are coming from  Gmail, Yahoo!
or Facebook etc. whereas the intention is to trick you into submitting your user and passcode.  
Thereafter these programmers (crackers as they are called) get into your account, picking up sensitive 
data, like bank account info, and also all your contacts so that these same messages are sent to them.  
None of the main cloud services will ask you for these details!  Moreover before clicking on any link, 
the mouse pointer, hoovering above the link will show the address of the link – often very different 
from the so-called author of the request.  Be very aware of clicking rapidly on links and much more so 
in giving out login details of any account.   
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Email Services

Of the email offerings – Yahoo!, Outlook.com (old Hotmail.com) etc, the well-known Gmail has been 
found to be very flexible with considerable storage and functionally.  The ability to use Gmail in 
tandem with an email-client such as Thunderbird provides the best of both worlds of Cloud and 
System-based software.  Thunderbird,  via the POP functionally of Gmail, can grab all the mail from 
the Gmail account as well as the sent mail via the Gmail account.  Thunderbird further extends the 
email environment with its own functionally as well as offering means to backup all mail, contacts and 
calender events – a very powerful combination.  Details to put in place this combination is provided in 
the Appendix.

Given this vulnerability of cloud-based services, the National Office makes use of its domain: bahai.ug 
such that all agencies have their respective email addresses linked to this domain.  The virtual server 
(presently via a member of the National Assembly) has a mail-server and this is used as a kind of 
“switch” which re-directs all mail to their respective Gmail addresses:  for example all mail going to 
SomeUser@example.com will automatically be forwarded to go to SomeUser@gmail.com  and so 
forth will all other agency mailboxes.  Thus in the unlikely event that SomeUser@gmail.com is 
compromised, another Gmail or email address can quickly be replaced without the need to inform the 
public about such change.

Moreover, all incoming mail to SomeUser@example.com would not only go to SomeUser@gmail.com
but second-copied to to another special mail box called archive@ example.com [which would go to 
SomeUser@outlook.com]

Similarly, all outgoing mail would make a blind-copy to archive@ example.com thus ensuring backups
of all out-going and incoming messages – for more detail see Appendix:  Backup with Email – National
Office Solution

This kind of server, as mentioned above to host the domain: eg.example.com, can be easily leased 
(~USD 200 from Linode.com.  Using an Ubuntu Server with the  iRedmail application (see the 
Handbook: Mail/Webserver Supplement), the setup and control of the Mail/Webserver remains under 
the direct control of National Office.

Here below is the schema on the flow of emails by this setup:
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Cloud Storage

There are several providers (eg Ubuntu, Dropbox)  offering “free” storage to a certain limit, like 5Gb or
more, before one acquires more space with payment.  As Gmail is a preferred cloud email service, the 
Google Drive is a natural choice as it integrates with Gmail and other Google services.  Moreover 
Google storage extends across Gmail and other services such that if one spend USD25 to upgrade to 
80Gb then this same storage is available to all Google services under one's user profile, services like 
Picasa Photo Albums etc.  The strongest virtues of Cloud storage is that it is available to one wherever 
one can have access to the Internet as well as the ability to share specific files with others.  Google 
Drive has also the additional virtue of having browser embedded applications such as Google Docs 
which allow editing of cloud-based files right in the browser itself.

Social Networks

General

Facebook, Twitter and G+ are among the most popular of the many social networks available on the 
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Internet.  These are powerful tools for communication on a scale never-before imagined and hence very
attractive to communities of all sorts.  Like all tools, there are wonderful and dangerous aspects.  One 
common danger with social networking is the posting of material and information which can lead to 
one's immediate or long-term embarrassment.  It has also the potential to affect negatively the 
reputation of entire communities.  Therefore one should always “err on the side of caution” and be on 
best behaviour – best language when using them.  For beginners, it is often better to use a mock name 
before graduating to one real name on these networks.  Many Bahá'í communities still refrain from 
making use of the remarkable tools but the trends show how popular and powerful these new tools are 
as well as they are free to use and feature-rich: the Bahá'í community needs to exploit better these 
networks.

Facebook

Facebook is among the first universal/international social networks – with practically 1 billion users.  
The Positives: This platform is a powerful tool to share information in form of texts, photos and videos.
Facebook can be use to share community events and give the public an idea of the dynamic activity of 
the community generally.  The Negatives: it is always open to the public in one way or another.  Once a
posting is made, it is difficult, if not impossible, to edit.  One must delete immediately and repost to 
correct errors.  Facebook arranges your postings/photos according to itself own framework which is, at 
times, annoying.

Twitter

Essentially build on the idea that short messages – known as “Tweets” (constrained on older mobile 
SMS systems to be 180 characters long) could be freely and frequently shared to a group.  The 
Positives: It was designed for the mobile phone environment, although now you can attach photos and 
videos to these “tweets”.  Ideal for a community where few members have Internet access but most 
have mobile phones.  The Negatives: the public still can see, one way or another, “tweets” from any 
account.  The “tweets” don't allow messages longer then 180 characters.

G+

G+ is Google's recent effort to catch up with Facebook and it's growth is now faster than that of 
Facebook so it is a serious contender – having currently about 300million users.  It has many 
similarities but also many differences to Facebook.  The Positives: It can share multiple line text, 
photos and video.  The privacy controls are much better than those of Facebook, such that Local 
Assemblies could sent private messages to its community members without such messages being 
exposed publicly.  It links into many of Google's other services – Gmail, Google Map, more 
importantly Google Calender; thus events in the community and their locations can be readily shared.  
The Negatives: The user has to understand the use of permissions and privacy controls in this new 
environment which is more complex than other networks – fortunately there are good help files that 
shorten the learning curve. 

Back Up Strategies
One should approach back-ups with the notion that if any cloud service, computer system or single file 
were to completely fail or get stolen at any given moment, there would be in place the know-how and 
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recent backups to recover from that situation.

Via Email

Both email-clients and cloud email services, such as Gmail, have powerful index and search features 
that allow one to find material via several parameters.  These features make them attractive platforms 
for backups.  For example, it is very easy to blind-copy (BCC) to the email address: archive@ 
example.com for safe keeping. A specific strategy is laid out in the Appendix: Backup with Email -  
National Office Solution.

Via Cloud and Physical Storage

Google Drive has a free downloadable application that will synchronize any computer folder with the 
Google Drive folder such that any file place in that particular folder will be uploaded to the Google 
Drive whenever the Internet connection is live.  

As mentioned above, all cloud data needs proper physical storage.  Flash keys or drives are still not 
secure and stable enough to be means for storage.  The best combination is to store data regularly on a 
portable hard-drive available with the Secretariat and do so according to schedule.  Critical to this kind 
of storing is a filing framework which enables one to find files rapidly.  By default all files will be 
stored chronologically according to the date of its last edit.  Folders need to be created by the user, 
defined headings, such as “Budgets”, “Reports” etc.  The recommend strategy is as follows:

1) Create a folder called “Current”: put all new and/or edited files into that folder during the work 
period designated between backups eg. One month, one week or one day – as decided.

2) Every week or whatever regular period chosen, copy the “Current” folder unto the portable 
harddrive, and add a date tag at the end of the backup folder such as Current131021.

[Note: the portable hard-drive with have a specific user-labelled folder in which each user will 
back up his/her data]  

[Note once these “Current Folder” become more than six or seven, delete the oldest one.]

3) Assured that “Current” folder is backed up, proceed and empty the move all files to their 
respective subject folders, eg. Budgets1213, Corres1213 etc.

4) Once these subject folders are updated and again, backup the revised subject folders to the 
office portable drive

5) Repeat at the next regular backup interval

6) In the same specific user folder, the user's Thunderbird profile also will be backed up regularly.

C:/Users/[yourname]/AppData/Roaming/Thunderbird/Profiles/XXXXXdefault

[Note: a shortcut to this profile folder will be established so to make that back up easier]

The Computer User
Every office should be having a central point of authority in the pool of computer of users, some of 
whom will have more access privileges than others.
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The Systems Manager

The systems manager is the central point of authority for all the computers within an office.  Within the
National Bahá'í Central, this authority is delegated by the National Secretary to the Office Coordinator. 
The Coordinator is required to manage a list (most often a spreadsheet) that contains user names and 
passwords for all the services and computer systems used in the National Centre much like a register 
and this register, let's call it the “eRegistry”, is made secure with a password known to the National 
Secretary, the Coordinator and whoever else designated by the National Assembly.  The structure of the
eRegistry is as follows:

Note that the column “filters” are active so that we could find entries quickly.

The Systems Manager would also be the recipient of backup copies from all agencies as to ensure 
protection and reliable restoration of data.  This could be done by receiving copies of all emails with 
their respective attachments, by receiving the DVD backups or better by having one or a set of portable
large-capacity hard-drives where the daily or weekly file folders of each agency is copied.

In summary, the Systems Manager has or does the following:

– the password privilege to the e-Registry which she/he may share with the National Secretary 
and Secretariat Coordinator.

– Coordinate with the Secretariat and Agencies the regular backup on to hard drives the essential 
files.

Authorized vs Guest User

All computer users are to have their respective logon on the computer(s) where they are working and 
each logon should have an appropriate password.  There should be no “open” guest account on any 
computer but a special user created, say “Visitor”, with limited privileges but with a common password
known to staff only.  Having this setup allows any true visitor, such as a Bahá'í volunteer or even a 
visiting Counsellor, to temporarily use an idle computer system.  In the opposite sense, all computer 
systems will have a “sysadmin” user with full privileges and where the password is known only to the 
Systems Manager so that he/she can a full access to the computer for maintenance and security issues.
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Appendix

Basic Hardware System (as of July 2013)

One needs to consider a strong brand that is fair easy to find on the Kampala market from reputable 
shop outlets (Mega Computers, PC World and a few others).  Brands such as Dell, HP, Toshiba, Acer, 
Asus are examples of such brands.  Each of these brands offer an entry level kind of model were the 
current offering usually has: 

– 4Gb ram (high-performance)

– 2+Ghz multi-core processor

– 500Gb hard-drive

– 17” colour monitor (for the desktop system - should be of the same brand and flicker free)

– Microsoft Windows 7 or 8 OS (properly licensed)

Models, such as the Dell Inspiron 660/660s Desktop or Laptop, the HP Pavilion, Toshiba Satellite and 
a few others, offer these level of specifications.  Note: The National Assembly has accepted as a good 
choice the HP Probook 4540s Intel Core3 with 4GB Ram and 500GB storage, running Win8 
Emerging.

Notes:

– It would be wise, if buying a laptop, to secure a proper carrying bag with it.  All new computer 
systems should have recovery CD's with them, along with a warranty.

– With regard to UPS units, essential for the desktop, a unit of 650watts is required and the 
batteries need to be replaced roughly every two - three years.  The battery must give at least 5-
10min of backup power.  No laser printers can be connected to these UPS units due to their high
power demand.

– Beware of counterfeits (but this should not be a problem if purchasing the unit from a well 
established computer outlet).

Basic Software

Top Priority

– Anti-virus: Kaspersky Anti-virus 2013  approx cost (70kUGX for 3 licences)

Essential

– LibreOffice (ver4.0.5 - 190MB)  which reads/writes MS documents (MS Office 2007/2010) – 
free download at : http://www.libreoffice.org/download

– Thunderbird 24.0.2 (20MB) a powerful mail-client that works well with Gmail account, freely
down-loadable at: https://www.mozilla.org/EN/thunderbird/   Moreover for full use of its 
calendar functionally, the extension: Lightning 2.6 (2.7MB) is to be installed – freely down-
loadable at: https://addons.mozilla.org/en-US/thunderbird/addon/lightning/?src=hp-dl-featured

– Adobe Reader XI (11.0.03) (47.79 MB) for viewing .pdf files – free download [but click off 
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choice of McAfee software] at: http://get.adobe.com/reader/

– Google Chrome [Internet browser at www.google.com/chrome ] or Firefox 
[http://www.mozilla.org/en-US/firefox/new/]  These may need the“Flash” plugin to view fully 
web pages.

Optional but very Useful Software

– GNU Cash v2.4.13 (105MB) for accounting – has a good range of reports free download at: 
http://www.gnucash.org/download.phtml

– GIMP 2.8.6 (>100 MB) for graphic manipulation – excellent set of graphic tools. Get this 
version at: http://www.gimp.org/downloads/

– IrfanView v4.36 (with plugins) also free alternative for graphic manipulation.  Get this version 
and plugins at: http://www.irfanview.com

– VLC 2.0.7-win32 (24 MB) to view video clips.  This is found at this site: 
http://www.videolan.org/vlc/download-windows.html

The Gmail – Thunderbird Combo

This powerful combination allows the user to benefit from Gmail with all its functionally but slso all 
the functionally with Thunderbird as one is able to load all out-going and incoming email.  Both 
platforms offer extensive index – search abilities.  However with Uganda's present lacklustre Internet 
services, it is often more useful to do search with emails that have been downloaded into Thunderbird.  

Our purpose here is to setup two accounts (as describe above under Email Services); 

-> For Receiving Mail: one to get mail from the Gmail account

-> For Sending Mail: from the “bahai.ug” account.

Here are the steps to setup up the combination:

 1. To receive mail: create a Gmail account – go to http://gmail.com  and signup up (have ready a 
good username and password beforehand)

 2. Login to your new Gmail account and go to “settings” [top right-hand corner – click on your 
username].

 3. User Settings: go to “Forwarding and POP/IMAP” and enable “POP” then signout.

 4. Install Thunderbird (and the add on extension: Lightning – this is optional but highly 
recommended)

 5. Open Thunderbird: click on “Existing Email Account”.

 6. Enter your new Gmail account (be sure that the computer has a live connection to the Internet) 
and Thunderbird then will ask for your password.  Thereafter, positively respond to all 
questions but choosing POP3 (not IMAP) and you have completed the process.  One can now 
sent and receive Gmail via Thunderbird.  

 7. The Thunderbird “Inbox” (from Gmail address) will fill up with “Get Mail”->”Gmail”  This is 
the priority receiving mailbox.  The details of this account needs to be shared with the 

A Computer Handbook Pg 13/19

http://gmail.com/
http://www.videolan.org/vlc/download-windows.html
http://www.irfanview.com/
http://www.gimp.org/downloads/
http://www.gnucash.org/download.phtml
http://www.mozilla.org/en-US/firefox/new/


Systems Administrator; details of the username and passcode.

 8. Similarly for sending mail, the System Administrator (see the National Coordinator) will give 
each user the related email account on the “example.com” domain (eg oea@example.com) with 
its respective passcode. Thereafter go to Thunderbird and under File->New->Existing 
Account:  

 a) Enter a name for the Account,

 b) Enter the email address and password given to you by the Systems Administrator

 c) Press the button “Continue”

 d) Here Thunderbird will initially find all the settings for this “example.com” account: Select 
POP3

 e) DO NOT press “Done” but press “Manual Config” and put in the full email address then 
press “Done” [Note: As Thunderbird only puts part of the username,  The full one is 
required; for example: eg not just “oea” but oea@example.com

 9. That complete, sent one test email from this account.  Thunderbird will first issue a warning – 
please accept the exception.  Try again sending the same email.  This second time will be 
successful.

 10. The Thunderbird “Sent” box (from the “bahai.ug”) will now fill with mail as you make 
this the priority sending account together with blind-copies (BCC) to 
archives@example.com (set this to be done automatically: see Tools->Account Settings-> 
[YourAcctTitle]->Copies&Folders; the bottom of the first section entitled “When sending 
messages, automatically” tick the BCC box and enter the email address.  In this case: 
archive@example.com)
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The Backup Process

 1. To Backup the “Inbox” and “Sent” boxes: In the left-side column, the main folder is called 
“Local Folders”, click on “Local Folders” and create for each year a folder, such as OEA2010, 
OEA2011 up to the current year OEA2013.

 2. Move all mail in their respective folders (accordingly to year).  

 3. At the end of the day or week, go to the “Inbox”, select (highlight) all mail entries with the key 
combination “Ctl-A” and drag the mail entries to the current year.  Do the same with the “Sent” 
box. [Note: In this manner, one quickly can assess the mail received and sent received]

 4. Thunderbird stores all user data in a subfolder – follow this trail:

 5. C:/Users/[yourname]/AppData/Roaming/Thunderbird/Profiles/XXXXXdefault   where 
XXXXXdefault is the directory where all your email data is stored.  Make a shortcut link to this
directory as you will go to it often for backup it up.  Copy all the files found in the entire 
directory to your user subdirectory for this purpose, usually called EmailBackup-[3LetterCode 
such as OEA]  for example on the portable hard-drive to finish the backup.

The Restore Process

To restore: Open the backup folder [eg. EmailBackup-OEA], select the folder therein, ending 
with .default and replace the same profile folder as per point 13.   Note: changes – particularly emails - 
that happen after the date that the backup was created will be lost – but you can get these emails 
directly from your Gmail account. 

AutoReply & Vacation Messages

While setting up an auto-reply or vacation messages as to acknowledge receipt of any emails or just to 
inform senders that replies may delay or be routed elsewhere, there are disadvantages in having these 
replies done continuously.  Notably, any spam message sent to email boxes that have auto-reply gives 
the spammer confirmation that this address is valid and reinforces more spam messages to follow.  
Note: For this very reason, Thunderbird default settings block images in emails unless the user accepts 
to download them.  Uploading images to emails is another way of confirming them read by the 
recipient  - this is confirmation is not to be given to spammers.

Return Receipt and Delivery Status Notification 

Thunderbird features Return Receipt and Delivery Status Notification. They are potent tools to confirm
the actual delivery and reading of a sent email.   

Status Notification is found under “Options” in the toolbar when composing an email.  When clicked 
on Status Notification, there is a check mark beside it and, once the email arrives at the recipient's 
email box, a confirmatory message is sent back to the sender to state that it has been received.     If 
there is no notification within 24 hours, re-send it,

Return Receipt is, likewise, found under “Options” in the toolbar when composing an email.  When 
clicked on Return Receipt, there is a check mark beside it and when the recipient opens this email, 
he/she is asked to confirm reading it.  If there is no confirmation in an acceptable period, it signals a 
need to contact the recipient in another manner to ensure that it is read.  Note that the confirmation 
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email will be sent by the mail server (currently named: lugazi.bbledger.com) with the generic name 
“Mail Delivery System” with a similar subject header “Successful Mail Delivery Report”.  Usually 
these go straight into “Spam” with the Gmail account.  One has to mark these as “Not Spam” so that 
future confirmations go to one's Inbox.

Notable Extras

Email address and even calender events can be ported from Thunderbird to Gmail / Google Calender.

Backup and Restore of MyDocuments Folder

The Backup of the User-Specific MyDocuments Folder

With the portable hard-drive and in the respective user folder therein, eg. ExternalAffairs, TplDirector, 
etc, there will be a subdirectory called MyData-[3LetterCode such as OEA] such as MyData-OEA.  In 
this respective subdirectory, the MyDocuments folder of each user is opened and the user's main 
directory on each computer have sub-directories called “My Documents”, “My Pictures”, etc.  Using 
Ctl-A to select at once all these sub-directories and thus “copies” all at a go to the user's specific 
directory (eg. MyData-OEA) on the hard-drive.

The Restore of the User-Specific MyDocuments Folder

Attach the portable hard-drive and 0pen the user-specific directory under  MyData-[3LetterCode such 
as OEA] such as MyData-OEA.  Drag the folder therein to the user's main directory – those directories 
that need restoring such as “My Pictures” or “My Documents” or all the folders, if need be by select 
them all with Ctl-A, then dragging them over.

Password Creation – Some Tips

Former password control limited the choice to alphanumeric characters (eg. Crane Bank); that is the  
letters and digits (A-Z, a-z, 0-9).  However many new password systems also allow most special 
characters such as %, &, +  to list a few. The addition of these special character and the often expanded 
length of passwords brings new strength and security to these systems.  In addition, it gives opportunity
to create passwords that are little bit more interesting.  

One of two important rules is to mix in the passwords, at least one of each of these groups

– Uppercase letters

– Lowercase letters

– Numbers

– Special Characters:  

! " # $ % & ' ( ) * + , - . / :
; < = > ? @ [ \ ] ^ _ ` { | } ~

The second important rule is to have passwords at least 9 places long (sometimes spaces are allowed).
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To now create a password, one just to think of a nonsensical but memorable short sentence – here is 
some examples that actually maybe easy to remember

cat8Alice@c  - is short for “cat ate Alice at sea” or  p'seGo!2bed   -  one 10 places long

If one needs to generate a passcode of good strength, here is a website for that:

http://strongpasswordgenerator.com/

File Naming – Some Tips

By default, most file listings are shown sorted in alphabetical order and dated according to its last edit.  
To exploit this correctly, thought needs to be given on how best to construct file names.  

For example, one wishes to have .pdf UMEME bill files for Kikaaya to be kept

a) in order of date then meter, then one will construct the file name in this manner: UMEME-
YYMMDD meter where YYMMDD is the numeric code for year, month and day then followed by 
“centre” or “adminhouse” for the meter name.  The listing will happen in this manner:

UMEME-130414 centre

UMEME-130420 adminhouse

UMEME-130512 centre

Result: all UMEME bills are found together, sorted by date.

b) in order of meter then date, then the file name would appear with this construct UMEME-
meterYYMMDD

UMEME-adminhouse130420

UMEME-centre130414

UMEME-centre130512

Result:  all UMEME bills are first sorted by location then by date.

To reverse the date format to DDMMYY would result in having all the first days of every month 
appearing together followed by the second of every month – not a practical application.

Recommended format:  [Source]YYMMDD[Target] [essential info]

– Where [Source] is the creator of the file and ideally, this is a 3 or 4 letter abbreviation such as 
NSA, CBC, RBCC (for RBC Central) etc

– Where date is YYMMDD such as 130926 for 26 September 2013 when the file is created.

– Where [Target] is the focus of the letter and where possible, it is again a 3 or 4 letter 
abbreviation such as those in source

– Where [essential info] contains keywords of subject of the file; eg. 'Rent', or events such as 
'Institute Gathering' etc
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File Handling and Storage

The inflow of email attachments and the creation of files quickly accumulates in the down-load 
directory or in the user document directory.  If not addressed, these directories become too large and 
disorderly.

To create order in filing and make easy backups, the following strategy is recommended:

1) Create a folder called “Current”; all downloads and newly created files are to be correctly 
named and placed soonest in this folder.  Preferably not on the C: drive but on another partition 
such as the D: drive

2) Create folders that are appropriate to your work but that end with a two digit year tag: 
YY – such as “Accounts13” or “Correspondence13”.  Create enough folders but not many as to 
place all your work in these categorically named folders. Again not on the C: drive but on 
another partition such as the D: drive.  Note: abbreviations here are also helpful such as 
“Accts13” or “Corres13”.  In the beginning of the new year create new folders.  

Then daily or weekly make a copy of the folder “Current” such as “Current2” then empty the 
“Current” folder by dragging all files into the categorically named folders, such as “Accounts13” etc, 
followed by saving these folders on the portable hard-drive as a backup.  Delete “Current2” if all 
copying has been done properly.  Store the portable hard-drive in a secure place.

Scanning Photos and Documents

For computers systems that have scanners, it is common to simply scan and send the scan by email.  
Often this results in a poor quality image that is very “big” in terms of memory (>1MB) which will be 
inconveniently slow to upload and even download for the recipient.  It is recommended to do three 
actions:

1- scan the document,  2 – adjust brightness and 3 - contrast and finally scale down the image.

The free graphic software “GIMP” is recommended and these would be the typical steps in fulfilling 
the three actions:

1. Open GIMP and place the document-to-be-scanned in the scanner (also turned on!)

2. In GIMP, select File->Create->Scanner/Camera->WIA-[Name of Scanner]

3. “What do you want to scan?” dialogue box: Select “Scan”  Results in image scan.

4. [Optional] In Toolbox, select the “Rectangle Select Tool”(rectangular icon – top left-hand 
corner.  Go to top left-hand corner of the desired area to keep and drag-click to bottom right-
hand corner to capture desired area.  Select menu: Image->Crop to Selection

5. Select menu: Colors->Curves.  This opens a dialogue box with a square with a “string” running 
from the top right-hand corner to the bottom left-hand corner.  With the cursor, drag-click up or 
down this “string” to improve brightness and contrast.  Press “OK” when finished.

6. Select menu: Image->Scale Image.  In the width box, enter a value of 800 (recommended) or 
1000 (higher resolution) and click on the button “Scale”

7. Select menu: File->Export.  Type in a file name ending with “.jpg” (note the period “.”) such as 
myscan.jpg, select the folder: “My Pictures” and press “Export” to save.  The image can now be
easily attached and sent in an email.
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Note: Use the “Snipping Tool” in the Microsoft accessory applications to capture part of the screen as 
an image – often the browsers turn up interesting information that can be captured and shared in this 
manner.

Recommended Service Points in ....

Links & References

1) Bahá'í Internet Agency: http://www.bcca.org/bia/
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